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Overview 
The Cobra 8.4 Cumulative Update 18 release includes all of the enhancements, software issues resolved, 
and database changes that were made in Cobra 8.4 CU 01 through CU 18. 

Custom Programs Affected 
Sometimes an update can cause custom programs and reports to stop working as expected. Before 
applying this update, consider whether you have any custom programs or reports in the application area 
affected by the update. If so, contact Deltek Customer Care at http://support.deltek.com before you install 
the update. 

 

Viewing the Online Help 
You may access the online help using Microsoft Edge, Chrome, and Firefox. The Cobra 8.4 Help System 
URL is https://help.deltek.com/Product/Cobra/8.4/GA. 

Software Requirements (Compatibility Matrix) 
To see the list of the supported and compatible technologies, see “System Requirements” in the Cobra 
8.4 Installation Guide. For a complete list of the recommended minimum software requirements, see the 
Deltek Product Support Compatibility Matrix document that you can download from the Deltek Customer 
Care Connect site. 

Attention: For steps to install the cumulative update, see “Appendix A: Download and Install the 
Cumulative Update” in this document. 

http://support.deltek.com/
https://help.deltek.com/Product/Cobra/8.4/GA/Cobra%208.0%20Help%20System.html
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=0A7B50C3-7EFE-4E04-BE47-91ADFE144464
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=0A7B50C3-7EFE-4E04-BE47-91ADFE144464
http://support.deltek.com/
http://support.deltek.com/
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Cobra 8.4 Cumulative Update 18 
Released: October 28, 2022 

Enhancements 
This section includes enhancements in this release. 

Cobra Web Service Update 
The Get Environment Details method has been updated to support checking of information related to the 
Cobra environment when using the Concurrency feature. 

Software Issues Resolved 
This section includes software issues resolved in this release.  

File » Integration Wizard–Project Data 

Defect 1622288  

Description: When you ran the Integration– Primavera Wizard to load code assignments from Primavera, 
Cobra did not filter the loaded values based on the filter selections in the Criteria field or the Filter 
activities loaded from the schedule option on the Filter page. 

Customers Impacted: This defect affects customers who load code assignments and filter the values on 
the Integration– Primavera Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Defect 1755891  

Description: When you ran the Integration Wizard to load control account level-code assignments, Cobra 
would only populate the control account-level values if there were code assignments loaded at the control 
account level. Previously, control account-level code assignments would be loaded using the work 
package-level code assignments.  

Customers Impacted: This defect affects customers who use the Integration Wizard to load control 
account level-code assignments.  

Workaround Before Fix: Load code assignments at the control account level by defining a separate 
activity with an empty work package key field value in the schedule.  

Files Updated: 

 Cobra.Process.dll  

Defect 1811373  

Description: If you upgraded MSP Server version 2013 to 2016 or higher, the database information 
sometimes contained information related to the old version, which could cause data loading issues when 
you used the MS Project–Integration Wizard. 

http://help.deltek.com/Product/Cobra/8.4/GA/api/html/M_Cobra_WebService_ClientAPI_Client_CobraServices_GetEnvironmentDetails.htm
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Customers Impacted: This defect affects customers who upgrade MSP Server version 2013 to 2016 or 
higher and use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Defect 1616046 

Description: When you ran the Integration Wizard to import control accounts and the Check Control 
Account field 1/2/3 structure for parent/child uniqueness option on the Project Preferences tab of the 
Project Properties dialog box was selected, Cobra ignored the option. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Installation 

Defect 1491872  

Description: When you installed Cobra on a non-default location in a server type deployment, the 
config.dat file was not created, and the installation log displayed checks that were not found. 

Customers Impacted: This defect affects all customers who install Cobra on a non-default location in a 
server type deployment. 

Workaround Before Fix: To have a working Cobra 8.4 in a server type deployment, install Cobra 8.2 
Cumulative Update 27 first, and then upgrade to Cobra 8.4 Cumulative Update 03. 

Files Updated: 

 DeltekCobra84.exe 

Reports » Reports 

Defect 161919  

Description: When you ran a Project Data report using any filter, the generated report displayed project–
level values in the control account rows. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll  

 Cobra.WinUI.*.dll  
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 Cobra.WinUI.exe 

Security Enhancements 
This section includes security defects resolved in this release. There are no security enhancements in this 
release. 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Online Help 

 Updated the Spread Dialog Box help topic to remove a misleading statement in 
the Use spread curve field description. 

Cobra 8.4 
Installation 
Guide 

 Added the “Error Encountered When Using ODBC Driver 18 for SQL Server” 
section. 

https://help.deltek.com/Product/Cobra/8.4/GA/Spread%20Dialog%20Box.html
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Cobra 8.4 Cumulative Update 17 
Released: September 30, 2022 

Enhancements 
This section includes enhancements in this release. 

BCR Analysis Report Template Update 
Previously, the “Is There a Change/Deletion?” column was placed inside of the Change Request sections 
in the BCR Analysis report. 

Now, when you generate the BCR Analysis report using the BCRAnalysis.xlsx template, the “Is There a 
Change/Deletion?” column is displayed after the Stage column on the Summary tab, making it more 
visible to the users. 

 

Sample Generated BCR Analysis Report Using the Updated BCRAnalysis.xlsx Template 

Support for Acumen 8.8 
Cobra now supports Acumen 8.8. 

 

Note: This is documented in the “System Requirements” section of the Cobra 8.4 Installation Guide 
and Cobra 8.4 Technical Overview and System Requirements Guide. 
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Software Issues Resolved 
This section includes software issues resolved in this release.  

File » Integration Wizard–Actual Costs 

Defect 1652155  

Description: When you ran the Integration–Actual Cost Wizard, Cobra encountered the following error if 
there was a control account that has the same naming convention as the control account/work package 
combo being imported: "The Control Account and Work Package keys being loaded into must be unique 
for the project." 

Customers Impacted: This defect affects customers who use the Integration–Actual Cost Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Process.dll 

File » Restore 

Defect 1708423  

Description: When you used a special character in the Oracle database password, the SQL Loader utility 
did not load the TPHASE, COSTELEM, AND BASEHIST data using Autorun. 

Customers Impacted: This defect affects customers who use SQL Loader to restore and have the 
configuration option for Autorun set to 1. 

Workaround Before Fix:  Use manual load for the SQL Loader utility and update the batch files by 
adding \" before and after the password. For example, \"p@ssword\".  

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Process.dll 

Help 

Defect 1723319  

Description: When you clicked the Help button on the Link to External Database page of the Data Tool 
Wizard, the corresponding help page did not display. 

Customers Impacted: This defect affects customers who use Cobra with PM Compass. 

Workaround Before Fix: None. 

Files Updated: 

 DataTool.UI.Base.dll  
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 DataTool.exe  

Projects » Project View 

Defect 1592858  

Description: When you set the baseline dates of a control account or work package to or prior to the 
project's status date, and the Prevent editing of historical time phased values option on the Project 
Preferences tab of the Project Properties dialog box was selected, Cobra allowed you to update the 
baseline dates in the Project view. 

Customers Impacted: This defect affects customers who use the Project view. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.Projects.dll 

 Cobra.Model.dll  

 Cobra.Resources.dll 

Security Enhancements 
This section includes security defects resolved in this release. There are no security enhancements in this 
release. 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Online Help 

 Updated the Replan help topic to remove the statement that is purely opinion 
in the Budget beyond the Status Date section. 

 Added the default user ID and password to log onto Cobra and EPM SA to the 
following topics: 

 Log Onto Cobra 

 EPM Security Administrator Functions 

https://help.deltek.com/Product/Cobra/8.4/GA/Replan.html
https://help.deltek.com/Product/Cobra/8.4/GA/Log%20Onto%20Cobra.html
https://help.deltek.com/Product/Cobra/8.4/GA/EPM%20Security%20Functions.html
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Cobra 8.4 Cumulative Update 16 
Released: August 31, 2022 

Enhancements 
This section includes enhancements in this release. 

Cobra Web Service Updates 
The following enhancements are made to the Cobra Web Service. 

Checking Information Related to the Cobra Environment 

The Cobra Web Service now supports the Get Environment Details method, which you use to check 
information related to the Cobra environment such as database version and application version. 

 

Filtering During Project Data Integration 

To support filtering when running project data integration through the Cobra Web Service, the Filter 
parameter has been added to the Integrate Project Data method.  

You can use the following values: 

 Criteria: This value refers to the criterion to use for project integration process. 

 DeleteSelectionCriteriaItemsOnly: This value specifies if the integration will delete only the 
items from Cobra that meet the criteria selected. 

 Selection: This value refers to the criteria filter that controls the portion of the project to be 
integrated. 

 

 

Support for New Products 
Cobra now supports the following products: 

 Microsoft Project Standard 2021  

 Microsoft Project Professional 2021 

 Microsoft Project Server 2021  

 Microsoft SQL Server 2019 Enterprise Edition 

Note: The Get Environment Details method is listed in the “Supported Operations” table of the 
Supported Processes, Operations, and Data topic in the Cobra Help System. 

Note: The Integrate Project Data method is listed in the “Supported Operations” table of the 
Supported Processes, Operations, and Data topic in the Cobra Help System. 

Attention: To display the Web Service Client API Help, click the following link: Web Services Client 
API. You can also navigate to the \Help\API subfolder of your Cobra installation folder. 

http://help.deltek.com/Product/Cobra/8.4/GA/api/html/M_Cobra_WebService_ClientAPI_Client_CobraServices_GetEnvironmentDetails.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/P_Cobra_Model_WebService_IntegrateProjectDataServiceArguments_Filter.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/P_Cobra_Model_WebService_IntegrateProjectDataServiceArguments_Filter.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/M_Cobra_WebService_ClientAPI_Application_Files_Integration_IntegrateProjectData.htm
https://help.deltek.com/Product/Cobra/8.4/GA/Supported%20Processes.html
https://help.deltek.com/Product/Cobra/8.4/GA/Supported%20Processes.html
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/R_Project_Web_Service_ClientAPI.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/R_Project_Web_Service_ClientAPI.htm
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 Microsoft Office 2021 

 Deltek Open Plan 8.6  

 

Software Issues Resolved 
This section includes software issues resolved in this release.  

File » Integration Wizard–Ancillary Data 

Defect 1602809 

Description: When you ran the Integration–Ancillary Data Wizard, Cobra would update or overwrite the 
imported file even if another user used it. 

Customers Impacted: This defect affects customers who use the Integration–Ancillary Data Wizard. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.Process.dll 

File » Integration Wizard–Project Data 

Defect 1711783 

Description: When you ran the Integration Wizard against a project with the Allow changes to scope 
for an in-progress Control Account/Work Package option on the Project– Preferences tab of the 
Project Properties dialog box selected, Cobra skipped loading of the resource assignments for in-
progress control accounts and work packages but did not display a warning message. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.Process.dll 

Defect 789837 

Description: When you ran the MS Project–Integration Wizard to load Microsoft Project Server data, and 
the MSP project title contained special XML characters in the title, the Schedule Project Lookup dialog 
box was empty. 

Customers Impacted: This defect affects customers who use the MS Project–Integration Wizard. 

Workaround Before Fix: Remove the special XML characters from the project title. 

Additional Notes: The same issue is encountered when loading Open Plan code fields and the code 
field description contains special XML characters. 

Files Updated: 

Note: These new products are documented in the “System Requirements” section of the Cobra 8.4 
Installation Guide and Cobra 8.4 Technical Overview and System Requirements Guide. 
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 Cobra.Process.dll 

Reports 

Defect 1730117 

Description: Creating BCR snapshots took longer than expected if the project was inserting many 
activities. 

Customers Impacted: This defect affects customers who use the BCR Analysis report feature. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WebService.dll 

 Cobra.WebService.Host.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Online Help 

 Generated the portable document format of the Cobra 8.4 Help System, which 
you can access through the Cobra 8.4 Help System main page. 

 Updated the Integration Wizard Preferences help topic to explain how the 
options in the dialog box affect new and existing configurations. 

https://help.deltek.com/Product/Cobra/8.4/GA/Cobra%208.0%20Help%20System.html
https://help.deltek.com/Product/Cobra/8.4/GA/Integration%20Wizard%20Preferences.html
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Cobra 8.4 Cumulative Update 15 
Released: July 29, 2022 

Enhancements 
This section includes enhancements in this release. 

Support for Microsoft Office 365 and Citrix Virtual Apps and Desktops 
7.x (Windows Server 2022) 
Cobra now supports the following deployment technologies: 

 Microsoft Office 365 

 Citrix Virtual Apps and Desktops 7.x (Windows Server 2022) 

Software Issues Resolved 
This section includes software issues resolved in this release.  

File » Integration Wizard–Project Data 

Defect 1612015 

Description: When you ran the Integration Wizard to load an existing configuration file and selected 
Control Account and Work Package in the Project Data field on the Action Selection page, Cobra 
encountered an "Unhandled Exception" error as you tried to complete the pages of the wizard. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

 Cobra.Model.dll 

File » Restore 

Defect 1716188  

Description: When you deleted a control account, work package, or resource assignment where an audit 
log adjustment was required, and another user or process held a lock on any of the control accounts in 
the project, Cobra did not adjust the audit log to account for the deleted work package. This defect 
occurred only when the project contained an internal DIR_UID with a length of 22 characters. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Additional Notes:  
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 If the delete action is performed in the Project view, a background process to adjust the audit log 
will execute and will continue to wait for the other lock(s) to be released until the retry count is 
reached before failing. There will not be any indication displayed in the Cobra user interface but 
there will be a Project Audit process entry in the Process Log viewer that shows the failed lock 
attempts.  

 If the delete action is performed through the DeleteWorkPackage Web Service, Cobra will wait for 
the other lock(s) to be released until the retry count is reached before failing and returning an 
error response to the caller. There will be a Project Audit process entry in the Process Log viewer 
that shows the failed lock attempts.  

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll  

 Cobra.Process.dll 

Projects » Project View 

Defect 1419576 

Description: When you deleted a control account or work package in the Project view, Cobra 
incremented the project's batch number. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Process.dll 

Project Processes » Calculate Forecast 

Defect 1694153  

Description: When you ran the Calculate Forecast Wizard against a forecast class that used the Coded 
Ranges forecast method, the values before the status date were not correctly processed if at least one of 
the Coded Ranges was not set to Manual Forecast (Retain EAC). 

Customers Impacted: This defect affects customers who use the Manual Forecast (Retain EAC) with 
Coded Ranges method. 

Workaround Before Fix: Calculate forecast by using the Manual Forecast Retain ETC method instead of 
Coded Ranges and then Manual Forecast Retain ETC). 

Files Updated: 
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 Cobra.Process.dll 

Defect 1708618  

Description: When you ran the Calculate Forecast Wizard, the calculated forecast value was zero if: 

 The forecast method used was Manual Forecast (Retain EAC).  

 The resource assignment had only one period on or before the status date.  

 The work package was planned.  

 The Spread ETC according to field on the Options page was set to Existing ETC Spread.  

Customers Impacted: This defect affects customers who use the Calculate Forecast Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Process.dll 

Defect 1714732 

Description: When you ran the Calculate Forecast Wizard, Cobra skipped the forecast calculation and 
encountered the "All the forecast spread periods for <CA/WP/Code/Class> are before the status date. 
Skipping the forecast calculation" error if: 

 The forecast method used was Manual Forecast (Retain EAC). 

 The resource assignment had only one period on or before the status date. 

 The work package was in-progress. 

Customers Impacted: This defect affects customers who use the Calculate Forecast Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements.  
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Document Details 

Cobra 8.4 
Installation 
Guide 

 Added the following technologies to the System Requirements section: 

 Citrix Virtual Apps and Desktops 7.x (Windows Server 2022)  

 Microsoft Office 365 

Cobra 8.4 
Technical 
Overview and 
System 
Requirements 
Guide 

 Added the following technologies to the System Requirements section: 

 Citrix Virtual Apps and Desktops 7.x (Windows Server 2022)  

 Microsoft Office 365 
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Cobra 8.4 Cumulative Update 14 
Released: July 1, 2022 

Enhancements 
This section includes enhancements in this release. 

Support for Windows 11 and Windows Server 2022 
Cobra now supports Microsoft Windows 11 and Microsoft Windows Server ® 2022. 

Software Issues Resolved 
This section includes software issues resolved in this release.  

File » Integration Cost Data Export 

Defect 1323258  

Description: When you ran the Cost Data Wizard to load an existing IPMDAR file, the Direct values and 
Indirect values options on the Data Options page were no longer selected. 

Customers Impacted: This defect affects customers who use the Cost Data Wizard. 

Workaround Before Fix: None.  

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe 

File » Integration Wizard–Project Data 

Defect 1477239  

Description: When you ran the Integration Wizard to load project data and the class being loaded (for 
example, "Forecast") had a name similar with another class (for example, "Forecast 2022") that used a 
different rate file without the rate set of the resource being loaded, Cobra encountered the "No rate found" 
warning message. 

Customers Impacted: This defect affects customers who use the Integration Wizard to load project data. 

Workaround Before Fix: None. 

Additional Notes: When classes have similar names, Cobra takes the rate file of the first class it sees 
during a process. If the class happens to have a different rate file from the class being loaded, Cobra 
uses this rate file instead of the one associated to the class being loaded. Thus, warnings are 
encountered when the rate file Cobra selects has missing rate set of the resource.  

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  
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 Cobra.Process.dll 

Project Processes » Calculate Forecast 

Defect 1700670 

Description: When you ran the Calculate Forecast Wizard, the time-phased spread of the Retain EAC 
forecast class would be spread incorrectly if the existing Retain EAC resource assignment contained zero 
time-phased periods stored in the database for some, but not all, of the zero time-phased periods. 

Customers Impacted: This defect affects customers who use the Calculate Forecast Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Project Processes » Calculate Progress 

Defect 1678508  

Description: When you ran the Calculate Progress process, Cobra intermittently encountered the error: 
"Unable to cast object of type 'Cobra.Model.DatasourceKeyIdentity' to type 'Cobra.Model.CobraIdentity'." 

Customers Impacted: This defect affects customers who run the Calculate Progress process on an n-tier 
deployment. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll  

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 
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Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Installation 
Guide 

 Updated Step 4 of Appendix H: Cobra Integration with Oracle PrimaveraP6 
API. 

 Updated Overview, Step 1, 2, and 3 of Appendix K: Managing BCR Snapshot 
Database. 

 Added Windows 11 and Windows Server 2022 to the Software Requirements 
section. 

Cobra 8.4 
Technical 
Overview and 
System 
Requirements 
Guide 

 Added Windows 11 and Windows Server 2022 to the Software Requirements 
section. 

Cobra 8.4 
Online Help 

 Moved the Concurrency setup information to a single document – Deltek PM 
Compass and Cobra Concurrency Solution Setup and Configuration Guide. 



Cobra 8.4 Cumulative Update 13 

Cumulative Update 18 Release Notes 18 

 

Cobra 8.4 Cumulative Update 13 
Released: June 1, 2022 

Enhancements 
This section includes enhancements in this release. 

Updates to the BCR Analysis Report Documentation and Scripts 
Location 
In Cobra 8.4 Cumulative Update 12, the steps to set up the BCR Snapshot database were documented in 
the Cobra Help System (BCR Analysis Report), and the required scripts to configure the BCR Snapshot 
database were attached to KBA # 105756-Managing BCR Snapshot Database to Support BCR Analysis 
Report for PM Compass in the Knowledge Center of the Deltek Support Center. 

Beginning with Cobra 8.4 Cumulative Update 13: 

 The required scripts are placed in the <Cobra 
installationdirectory>\Samples\Cobra84PMCompassBCRScripts folder when you install 
Cobra. This folder contains the following sub-folders: 

 Data Tool: This folder contains the DataTool.sdf file. 

 Oracle: This folder contains the Create and Upgrade scripts for Oracle databases. 

 Sample: This folder contains the RecreateAsGlobalTempTables_Oracle.sqll file. 

 SQL: This folder contains the Create and Upgrade scripts for MS SQL databases. 

 The steps to set up the BCR Snapshot database are discussed in detail in “Appendix K: 
Managing BCR Snapshot Database” of the Cobra 8.4 Installation Guide. 

Software Issues Resolved 
This section includes software issues resolved in this release.  

API » Web Services 

Defect 1643426  

Description: When the Prevent editing Time Phased Grid option was selected for a class, and a work 
package included that class, the Cobra Web Service did not allow the deletion of the work package.  

Customers Impacted: This defect affects customers who integrate Cobra with PM Compass.  

Workaround Before Fix: None.  

Files Updated: 

 Cobra.Model.dll  

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.WebService.dll  

 Cobra.WebService.Host.exe  
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File » Integration Wizard–Project Data 

Defect 1675021  

Description: When the Project lock setting field on the Data Access tab of the Application Preferences 
dialog box was set to Control Account, and you ran the Integration Wizard to load an empty activity file 
on the Project Selection page, and selected the Delete Control Accounts and Work Packages no 
longer in the schedule option on the Change Control page, Cobra displayed a "locked by another user" 
warning and did not delete the work packages. 

Customers Impacted: This defect affects customers who use the Integration Wizard with Project lock 
setting set to Control Account. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Process.dll 

Defect 1620122  

Description: If the Force existing Work Package dates to match the schedule for option on the 
Integration Wizard–Preferences tab of the Project Properties dialog box was both Selected and Secure, 
the integration failed to complete and the process log was blank. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: Clear the Secure checkbox for the Force existing Work Package dates to 
match the schedule for option. 

Additional Notes: This was fixed as part of Defect 29519 in Cobra 8.4 Cumulative Update 12. 

Files Updated: 

 N/A  

Project Processes » Calculate Forecast 

Defect 1678969  

Description: When you ran the Calculate Forecast Wizard to run concurrent forecast calculations, Cobra 
encountered the "ORA-00904: "CAWP"."CAWPID": invalid identifier" error. 

Customers Impacted: This defect affects customers who use the concurrency feature. 

Workaround Before: Clear the Send to process server check box on the Run page. 

Additional Notes: The error does not occur when you run the Calculate Forecast process ((without the 
concurrency feature) or other processes with concurrency feature. 

Files Updated: 

 Cobra.Process.dll 
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Projects » Project View 

Defect 1515072  

Description: When you changed the progress technique of a work package to Apportioned, the 
progress technique returned to its previous value after you expanded the same control account to be 
apportioned in the Work Package Lookup dialog box. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: Perform the following steps: 

1. In the Spreadsheet pane of the Project, reselect the control account and then work 
package.  

2. On the General tab (below), select Apportioned in the Progress Technique drop-down 
list.  

3. Click the Apportioned to field and select the work package.  

4. Click Save to reflect your changes.  

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Online Help 

 Updated the BCR Analysis Report help topic to reflect the change in the BCR 
scripts location. 

 Moved the BCR Analysis report documentation to “Appendix K: Managing BCR 
Snapshot Database” of the Cobra 8.4 Installation Guide. 

Cobra 8.4 
Installation 
Guide 

 Updated “Appendix K: Managing BCR Snapshot Database” to include all BCR 
Analysis report documentation, previously located in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/BCR%20Analysis%20Report.html
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Cobra 8.4 Cumulative Update 12 
Released: April 29, 2022 

Enhancements 
This section includes enhancements in this release. 

Support for BCR Analysis Report in PM Compass 
The Budget Change Request (BCR) Analysis report, which is generated in PM Compass, provides a 
summary and detailed information about the changes processed in a particular period. The BCR Analysis 
report displays before and after data for change requests processed for a period and highlights any 
discrepancies; that is, data that was not processed as planned. 

 

In order to run the BCR Analysis report, you must first set up the BCR Snapshot database using the 
Cobra Data Tool. The BCR Snapshot database must have a schema that matches your production or 
source database.  

 

Once the BCR Snapshot database is set up, open PM Compass and access the BCR Analysis Report 
form, where you can filter the data that you want to in the report, and run the report itself.  

 

To support running the BCR Analysis report in Cobra, a new page labeled Link to External Database 
has been added to the Cobra Data Tool Wizard. By using the Link to External Database page, you can 
link the main database to the BCR Snapshot database. The BCR Snapshot database will hold the 
snapshots of your project throughout the Budget Change Request workflow completion. To ensure that 
the BCR Analysis Reporting feature works correctly, the main database and the BCR Snapshot database 
must have the same tables, configuration, and product version. 

The Link to External Database page is placed after the Options page or the Define Results page, and 
before the Confirmation page of the Cobra Data Tool Wizard. This page displays if the main database 

Note: The BCR Analysis report feature is available if you are using Cobra 8.4 Cumulative Update 12 
and PM Compass 8.2 Cumulative Update 10, at the minimum. 

Note: The scripts you need to set up the BCR Snapshot database are attached to KB Article #105756 
–Managing BCR Snapshot Database to Support BCR Analysis Report for PM Compass in the 
Knowledge Center of the Deltek Support Center. Contact Deltek Customer Care should you need 
assistance in downloading the scripts. 

 BCRReportingFeatureScriptsandFiles.zip 

For detailed steps to set up the BCR Snapshot database using the Cobra Data Tool, see the following 
topics in the BCR Analysis Report node of the Cobra Help System: 

 BCR Analysis Report Requirements 

 Implementation Summary 

 Additional Topics 

Attention: For more information, refer to the topics in the Reports » BCR Analysis Report node of 
the PM Compass Help System or the PM Compass 8.2 Cumulative Update 10 Release Notes. 

https://help.deltek.com/Product/Cobra/8.4/GA/BCR%20Analysis%20Report.html
https://help.deltek.com/Product/Cobra/8.4/GA/BCR%20Analysis%20Report%20Requirements.html
https://help.deltek.com/Product/Cobra/8.4/GA/BCR%20Implementation%20Summary.html
https://help.deltek.com/Product/Cobra/8.4/GA/BCR%20Additional%20Topics.html
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contains PM Compass 8.2 tables. You must configure this page with the connection details of the BCR 
Snapshot database. If not configured, you will not be able to utilize the BCR Analysis Reporting feature. 

 

Link to External Database Page of the Data Tool Wizard 

 

Cobra Project Name Displayed in the DCDE Report 
When you generate the Deltek Common Data Exchange (DCDE) report using the Cost Data Wizard, the 
Cobra project name specified in the Name field on the General tab of the Project Properties dialog box 
now displays in the generated report. 

 

General Tab of the Project Properties Dialog Box 

Note: The Link to External Database Page is documented in the Cobra Data Tool Help.  

To display the Cobra Data Tool Help, click the Help button on any of the Wizard pages, or navigate to 

the Help sub-folder of the Cobra installation directory, and double-click DataTool.chm. 
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Generated DCDE Report 

Support for SQL Server–Windows Authentication in PM Compass 
Weblink 
Cobra Web Service now supports SQL Server–Windows Authentication when the database connection is 
configured in PM Compass Weblink. 

Software Issues Resolved 
This section includes software issues resolved in this release.  

API » Web Services 

Defect 1635429  

Description: When the Prevent editing Time Phased Grid option was selected, the Cobra Web Service 
did not delete the resource assignment. 

Customers Impacted: This defect affects customers who integrate Cobra with PM Compass. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll  

 Cobra.WebService.dll  

 Cobra.WebService.Host.exe  
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File » Integration Wizard-Ancillary Data 

Defect 229519 

Description: When you ran the Integration Wizard to load code assignments, and the Update Control 
Account dates to span Work Package dates exactly option on the Integration Wizard–Preferences tab 
of the Project Properties dialog box was selected, the integration tried to force the control account dates 
to match the work package dates even if the dates were not being updated, causing Cobra to encounter 
an error. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: Ignore the error as the code assignments are imported correctly. Clear the 
Update Control Account dates to span Work Package dates exactly option on the Integration 
Wizard–Preferences tab of the Project Properties dialog box, and then run the Integration Wizard again. 

Files Updated: 

 Cobra.Process.dll 

Projects » Project View 

Defect 1585284  

Description: When users were logged out of Cobra due to exceeding the value specified in the Max 
Time of Inactivity field in EPM Security Administrator (EPM SA), Cobra did not release the object lock.  

Customers Impacted: This defect affects all customers.  

Workaround Before Fix: None.  

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll  

 PPM.Engine.Security.dll  

Project Processes » Recalc 

Defect 1324487  

Description: When you ran the Recalc Wizard, Cobra incorrectly recalculated the cost for a forecast 
class if: 

 The forecast dates in the Spreadsheet pane of the Project view were different from the baselines 
dates.  

 The calculated time-phased period fell in multiple periods of a rate set.  

 The periods of the rate set to calculate cost changed when using forecast date set versus the 
baseline date set.  

Customers Impacted: This defect affects customers who use the Recalc Wizard. 

Workaround Before Fix: None. 
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Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Reports » Reports 

Defect 914680  

Description: When you ran some reports, Cobra encountered the "Invalid date format" or "Unhandled 
Exception" error if you were using SQL Native Client 11 or Microsoft OLE DB Driver for SQL Server data 
provider. 

Customers Impacted: This defect affects customers who use Cobra with SQL Native Client 11 or 
Microsoft OLE DB Driver for SQL Server data provider. 

Workaround Before Fix: Use SQL Server .Net Framework data provider.  

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Online Help 

 Added BCR Analysis Report help topics for the Support for BCR Analysis 
Report in PM Compass enhancement. 

Cobra 8.4 
Installation 
Guide 

 Added “Appendix K: Managing BCR Snapshot Database”. 

Data Tool Help 
System  

 Added the “Link to External Database” help topic. 
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Cobra 8.4 Cumulative Update 11 
Released: April 5, 2022 

Enhancements 
This section includes enhancements in this release. 

Managing Instances and Gateway Endpoints using the Cobra Web 
Service Management Tool 
Managing Cobra Web Service instances and gateway endpoints require you to perform several tasks and 
use different interfaces. 

To install an instance, you need to modify the configuration files and run a command line. To reconfigure 
an instance, you need to stop the service, modify the configuration file, and start the service again. These 
methods are sometimes susceptible to errors that may break the instance or gateway endpoints. 

The Cobra Web Service Management Tool is created to streamline and automate the methods by 
providing the following functions: 

 Set up the Cobra Web Service instances and gateway endpoints through an intuitive user 
interface 

 Install and delete instances and gateway endpoints without using the Windows command line 

 Start, restart, and stop instances and gateway endpoints without accessing Windows Services 
Manager (Services MMC) 

The Cobra Web Service Management Tool does not include managing SSL certificates needed to set up 
Cobra Web Service instances and gateway endpoint that use the HTTPS protocol. To support SSL in 
Cobra Web Service instances and gateway, you must bind the HTTPS ports to be used by these services 
to Windows Server Certificates.  

 

In addition, the Cobra Web Service Gateway Configuration Tool, previously a stand-alone tool, has been 
merged into the Cobra Web Service Management Tool. 

The Cobra Web Service Management Tool consists of two panes: the left pane and the right pane. 

The left pane contains the following sections: 

 Toolbar 

 Instances Tree 

 Gateway Tree 

The section displayed in the right pane of the Cobra Web Service Management Tool depends on what is 
selected in the left pane. 

 If an instance or <New Instance> is selected in the left pane of the tool, the Cobra Web Service 
Instance Settings displays in the right pane. 

Attention: For more information, see Configuring Cobra Web Service to Use Secure Socket Layers 
in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Configuring%20the%20CWS%20to%20Use%20SSL.html
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 If the gateway is selected in the left pane of the tool, the Cobra Web Service Gateway Settings 
displays in the right pane. 
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When you launch the Cobra Web Service Management Tool, it performs the following actions: 

 Retrieves all services that execute the Cobra.WebService.Host.exe in Windows Services  

 Reflects the status of each instance 

 Locates the Cobra.WebService.Gateway.Host.exe in Windows Services 

 Loads the Cobra.WebService.Gateway.Host.exe.config file into the Cobra Web Service Gateway 
Settings 

 

Software Issues Resolved 
This section includes software issues resolved in this release.  

API » PMC Web Services 

Defect 1622956  

Description: When you used multiple SQL Server database connections with the same instance and 
username to run workflows in PM Compass, the Cobra Web Service encountered errors. 

Customers Impacted: This defect affects customers who run workflows in PM Compass using multiple 
SQL Server databases with the same instance and username. 

Workaround Before Fix: None.  

Files Updated: 

 Cobra.WebService.dll  

 Cobra.WebService.Host.exe 

File » Integration Wizard-Project Data 

Defect 1616207 

Description: When you ran the Integration Wizard to load schedule code file from Open Plan, Cobra 
displayed that the integration had completed with errors, but the process log was empty, and the codes 
were not imported. 

Customers Impacted: This defect affects customers who use the Open Plan–Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Attention: For more information about the panes and fields in the tool, see the topics in the Cobra 
Web Service Management Tool node of the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Cobra%20Web%20Service%20Management%20Tool.html
https://help.deltek.com/Product/Cobra/8.4/GA/Cobra%20Web%20Service%20Management%20Tool.html
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Projects » Project View 

Defect 1519965 

Description: When you were in the Project view and you selected a different value in the Result drop-
down list on the Edit tab, Cobra took a long time to load the values in the Time-phase pane. 

Customers Impacted: This defect affects customers who use the Project view on a Microsoft SQL 
Server database. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Project Processes » Calculate Forecast 

Defect 1461013  

Description: When you ran the Calculate Forecast Wizard, Cobra changed the time-phase spread for 
forecast resource assignments that contained zero time-phased periods. 

Customers Impacted: This defect affects customers who use the Calculate Forecast Wizard. 

Workaround Before Fix: Run the Assignment Export/Import Wizard against the forecast resource 
assignments.  

Files Updated: 

 Cobra.Process.dll 

Defect 1610376  

Description: When you ran the Calculate Forecast Wizard against a class that used the Coded Ranges 
forecast method, with one of the ranges set to Manual Forecast (Retain EAC) method but without future 
forecasts, Cobra deleted the past forecasts without making the adjustments in the future and caused the 
EAC to be reduced. 

Customers Impacted: This defect affects customers who use the Manual Forecast (Retain EAC) with 
Coded Ranges method. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Process.dll 



Cobra 8.4 Cumulative Update 11 

Cumulative Update 18 Release Notes 30 

 

Defect 1630956 

Description: When you ran the Calculate Forecast Wizard and selected Budget in the Spread ETC 
according to drop-down list on the Options page, Cobra did not spread the forecast correctly using the 
Budget spread. 

Customer Impacted: This defect affects customers who use the Calculate Forecast Wizard. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.Process.dll 

Reports » Report View 

Defect 1610547  

Description: When you ran the IPMR Format 1 or CPR Format 1 report, the Variance Adjustments Total 
field (block 9a) had a different format than the rest of the fields in the generated report.  

Customers Impacted: This defect affects customers who run the IPMR Format 1 or CPR Format 1 
report. 

Workaround Before Fix: None. 

Files Updated:  

 cpr format 1.xlsx 

 IPMR CPR Format 1.xlsx 

Security 

Defect 1616326  

Description: Cobra was not installing the latest version of the MSCOMCTL.OCX file. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: Download the latest version of the MSCOMCTL.OCX file from the Microsoft 
website and install it. 

Additional Notes: When there is no Cobra Workstation Administration Tools feature installed, the 
MSCOMCTL.OCX file in the Workstation server is not automatically updated in C:\Windows\SysWOW64 
during installation. 

Files Updated: 

 DeltekCobra84.exe 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 
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Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Online Help 

 Created the following topics for the "Managing Instances and Gateway 
Endpoints using the Cobra Web Service Management Tool" enhancement: 

 Cobra Web Service Management Tool 

 Configuring Cobra Web Service to Use Secure Socket Layers 

 Added and/or updated references to the Cobra Web Service Management 
Tool in the following topics: 

 Cobra Web Service Log 

 Create the Cobra Web Service Gateway 

 Create the Cobra Web Service Gateway 

 Deploy the Cobra Web Service Host  

 Deploy the Cobra Web Service ClientAPI 

 Deploying the Cobra Web Service 

 Host the Cobra Web Service Instances  

 Register the Gateway in Windows Services 

 Unregister the Gateway from Windows Services 



Cobra 8.4 Cumulative Update 10 

Cumulative Update 18 Release Notes 32 

 

Cobra 8.4 Cumulative Update 10 
Released: March 4, 2022 

Enhancements 
This section includes enhancements in this release. 

Support for Concurrent Forecast Calculations 
Cobra now supports concurrency in running forecast calculations on batches of control accounts. For 
example, a project can be split into multiple jobs, with each job processing a different batch of control 
accounts concurrently. 

To use this feature, you must understand the following information and requirements: 

 You must know the requirements and steps to set up your environment to run a concurrent 
process. 

 You are running the concurrent forecast calculations against a single project. 

 You are not running the concurrent forecast calculations against Frozen Forecast classes. 

 The apportionment mapping target is set to <Same as Source> or <Same as Source> \ WP for 
all control accounts in the apportionment mapping definition. 

 You have specified the number of control accounts to process per batch in the Control Accounts 
per queue field on the Data Access tab of the Application Preferences dialog box. 

After you set up your environment for the concurrent forecast calculations and you run the Calculate 
Forecast Wizard, the Run page displays after the Forecast Class Selection page. 

 

 
Run Page of the Calculate Forecast Wizard  

Note: If you select a forecast class that uses the forecast method PF=Unit input on the Forecast 
Class Selection page, the Run page displays after the Manual Performance Factors page. 

https://help.deltek.com/Product/Cobra/8.4/GA/Concurrency%20Requirements.html
https://help.deltek.com/Product/Cobra/8.4/GA/Implementing%20Concurrency.html
https://help.deltek.com/Product/Cobra/8.4/GA/Data%20Access%20Tab%20of%20the%20Application%20Preferences%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.4/GA/Calculate%20Forecast%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Calculate%20Forecast%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Run%20Page%20of%20the%20Calculate%20Forecast%20Wizard.html
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If you select the Send to process server check box, Cobra groups the control accounts into multiple 
batches (according to the value specified in the Control Accounts per queue field on the Data Access 
tab of the Application dialog box), queues the forecast calculation job to the Process Server, and displays 
the Process Complete page immediately. 

 

Data Access Tab of the Application Preferences Dialog Box 

 

Loading Budget Resources during Schedule Integration through the 
Cobra Web Services 
When running the Schedule Integration through the Cobra Web Services, you can now define how budget 
resources are imported into the Cobra project from the scheduling tool. 

The following new parameters are added: 

 LoadOptions: This parameter determines how the budget class will be imported to the budget 
resource assignment data. This parameter can contain one of the following: 

 LoadAllBudgetIntoDefaultClass: This value informs Cobra to import all resource 
assignments into the same class. 

 LoadBudgetClassFromField: This value informs Cobra to use a schedule field that has the 
budget classes to import resource assignments. 

 LoadFromField: This parameter determines the schedule field that has the budget class that will 
be imported to the budget resource assignment data.  

 LoadFilterClassList: This parameter determines the list of classes that will only be included in 
importing budget resource assignment data.  

Attention: For more information, see the “Concurrent Forecast Calculations” and “Concurrency in 
Cobra” help topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Concurrent%20Forecast%20Calculations.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrency%20in%20Cobra.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrency%20in%20Cobra.html
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The following Web Service Client API Help topics have been updated for this enhancement: 

 IntegrateProjectDataServiceArguments.BudgetCriteria Class: The new parameters are added to 
the BudgetCriteria class in this topic. 

 IntegrateProjectDataServiceArguments Class: The new parameters are referenced as the Budget 
property of IntegrateProjectDataServiceArguments class in this topic. 

Software Issues Resolved 
This section includes software issues resolved in this release. 

File » Integration Cost Data Export 

Defect 1485584  

Description: When you ran the Cost Data Export process to export to a JSON file, the ReportingPeriodID 
value was missing if the total dollars of the combined actual classes totaled to zero while the hours on 
those same classes did not. 

Customers Impacted: This defect affects customers who use the Cost Data Export process. 

Workaround Before Fix: None. 

Files Updated: 

 PPM.CommonData.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

File » Integration Wizard-Project Data 

Defect 886533  

Description: When you ran the Integration Wizard to load Microsoft Project data from an XML file, the 
Cobra time-phasing spread did not match the time-phasing of data in Microsoft Project. 

Customers Impacted: This defect affects customers who load data from MS Project XML files using the 
MS Project Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Note: These parameters correspond to the fields in the Budget group box on the Resource 
Assignments page of the Integration Wizard. 

http://help.deltek.com/Product/Cobra/8.4/GA/api/html/R_Project_Web_Service_ClientAPI.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_Model_WebService_IntegrateProjectDataServiceArguments_BudgetCriteria.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_Model_WebService_IntegrateProjectDataServiceArguments.htm
https://help.deltek.com/Product/Cobra/8.4/GA/Resource%20Assignments%20Page%20of%20the%20Integration%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Resource%20Assignments%20Page%20of%20the%20Integration%20Wizard.html
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Defect 1601367  

Description: When you ran the Integration Wizard, loaded an empty activity file on the Project Selection 
page, and selected the Delete Control Accounts and Work Packages no longer in the schedule 
option on the Change Control page, Cobra did not delete the work packages. 

Customers Impacted: This defect affects customers who use the Transaction–File Integration Wizard. 

Workaround Before Fix: You can load a transaction file with a single record that creates dummy work 
packages. When the process is completed, the filtered work packages will be deleted. You can then 
delete the dummy work packages. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1603521  

Description: When you ran the Integration Wizard to load schedule from Open Plan, Cobra changed the 
work package Baseline Start date to Open Plan's Schedule Start date of the baseline activity even if the 
Prevent editing of historical time phased values option on Project Preferences tab of the Project 
Properties dialog box was selected, and the baseline start date was set prior to the status date. 

Customers Impacted: This defect affects customers who use the Open Plan–Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Defect 1590968  

Description: When you ran the Integration Wizard to load an existing configuration and then updated the 
selection in the Force existing Work Package dates to match the schedule for field on the Change 
Control page, Cobra did not save your changes. 

Customers Impacted: This defect affects customers who use the Transaction–File Integration Wizard. 

Workaround Before Fix: Create a new configuration instead of loading an existing one. 

Files Updated: 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Installation 

Defect 1599389  

Description: Cobra was installing the old version of the MSCOMCTL.OCX file used by the EPM Security 
Administrator tool. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: Download the latest version of the MSCOMCTL.OCX file from the Microsoft 
website and install it. 
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Files Updated: 

 DeltekCobra84.exe 

Project Processes » Freeze Forecast 

Defect 169968  

Description: When you ran the Freeze Forecast Wizard, Cobra encountered the "Forecast class XXX are 
not at the same level as Cost Set XXX” error if the included forecast classes in the Forecast Cost Set 
pane were set to both control account and work package levels, and a frozen forecast class set at the 
control account level was selected in the Copy To class field in the Frozen Forecast Class pane. 

Customers Impacted: This defect affects customers who use the Freeze Forecast Wizard. 

Workaround Before Fix: Run the Reclass Wizard to copy the forecast class at the work package level to 
a forecast class at the control account level, and then run the Freeze Forecast Wizard. 

Files Updated: 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Project Processes » Reclass 

Defect 1605257  

Description: When you ran the Reclass Wizard and the target class type was Actual or Progress, Cobra 
encountered the "LCCALENDAR' is not found" error if one of these scenarios applied: 

 The Copy resource assignment codes from option on the Options page was set to Target. 

 The target class and the source class were at different levels. 

Customers Impacted: This defect affects customers who use the Reclass Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1609692  

Description: When you ran the Reclass Wizard, the reclass values were incorrect if: 

 The Source Class page was set to Copy, the Target Class page was set to Replace existing, 
and the target class and the source class were at different levels. 

 The project contained records with code that was a subset of another code (for example, ASTRO 
and ASTRO1). 

 The target class was a budget or forecast class, and the calendar dates were different from the 
source class calendar. 

Customer Impacted: This defect affects customers who use the Reclass Wizard. 

Workaround Before Fix: None. 
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Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1597539  

Description: When you ran the Reclass Wizard, Cobra did not create the target resource if: 

 The Source Class page was set to Copy. 

 The Target Class page was set to Replace existing. 

 The Date Range page was not set to Reclass all periods in your project. 

Customers Impacted: This defect affects customers who use the Reclass Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Reports » Reports 

Defect 621652  

Description: When you ran the IPMR CPR Format 1 or CPR Format 1 report using a master project, the 
Target Profit or box5d amount in the generated report was incorrect. 

Customers Impacted: This defect affects customers who run the IPMR CPR Format 1 or CPR Format 1 
report. 

Workaround Before Fix: None. 

Files Updated: 

 cpr format 1.xlsx 

 IPMR CPR Format 1.xlsx 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 
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Document Details 

Cobra 8.4 
Online Help 

Created the following help topics for the Concurrent  Forecast Calculations feature: 

 Concurrent Forecast Calculations 

 Run Concurrent Forecast Calculations 

 Run Page of the Calculate Forecast Wizard 

Cobra 8.4 
Installation 
Guide 

Updated Step 4 of the “Add a New Data Source” section with instructions applicable 
to every database server type. 
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Cobra 8.4 Cumulative Update 09 
Released: February 4, 2022 

Enhancements 
This section includes enhancements in this release. There are no enhancements in this release. 

Software Issues Resolved 
This section includes software issues resolved in this release. 

Documentation 

Defect 1589598  

Description: The Cobra Help did not contain sufficient information about loading actual cost records from 
a SQL Server database table during integration. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Additional Notes: The steps to load actual costs from a SQL Server database table is now documented 
in the "Create an MS SQL Database Connection to Load Actual Costs" help topic. 

Files Updated: 

 Create a MS SQL Database Connection to Load Actual Costs.html 

 Database Table Selection Page of the Integration Wizard Actuals.html 

 File Selection Page of the Integration Wizard Actuals.html 

 Loading Actual Cost Records from a Database Table.html 

File » Integration Cost Data Export 

Defect 1510620  

Description: When you ran the Cost Data Export process to export to a JSON or DCDE file, the earned 
values for the Management Reserve (MR) and Undistributed Budget (UB) included zero values for the 
fields that were not applicable. 

Customers Impacted: This defect affects customers who use the Cost Data Export process. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

https://help.deltek.com/Product/Cobra/8.4/GA/Create%20a%20MS%20SQL%20Database%20Connection%20to%20Load%20Actual%20Costs.html
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File » Integration wInsight 

Defect 1592177  

Description: When you ran the wInsight Export process, the UNCEFACT was not generated if the 
narrative text contained non–breaking spaces. 

Customers Impacted: This defect affects customers who use the wInsight Export process. 

Workaround Before Fix: Edit the narrative text by removing the non–breaking spaces and replacing 
them with spaces. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 562503  

Description: When you ran the wInsight Export process, the UNCEFACT was not generated if the control 
account code in the Spreadsheet pane of the Project view contained special characters (&, >, <, ", ', |). 

Customers Impacted: This defect affects customers who use the wInsight Export process. 

Workaround Before Fix: Edit the control account code by removing the special characters. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1321280  

Description: When you ran the wInsight Export process to add dummy work packages for actuals and 
the Level at which to capture actual costs field on Files tab of the Project Properties dialog box was set 
to Both Control Account & Work Package, the generated XML file did not contain burden values for 
budget and progress. 

Customers Impacted: This defect affects customers who use the wInsight Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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File » Integration Wizard-Project Data 

Defect 1568599  

Description: When you ran the Integration Wizard and the Prevent editing of historical time phased 
values option on the Project Preferences tab of the Project Properties dialog box was selected, Cobra 
updated the baseline dates before the status date. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

Reports » Report Wizard 

Defect 460631  

Description: When you opened the Manage Filters dialog box, report filters to which you did not have 
access were displayed. 

Customers Impacted: This defect affects all non-Cobra administrators using the Manage Filters dialog 
box. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Reports » Reports 

Defect 401984  

Description: The Description column header for Export Rates report was incorrect. 

Customers Impacted: This defect affects customers who generate Export Rates report. 

Workaround Before Fix: Correct the column heading in the generated report. 

Files Updated:  

 export rates.xlsx 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 
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Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Online Help 

 Made the following updates to the Cobra Online Help for Defect 158959: 

 Documented steps to load actual costs from a SQL Server database table 
in the "Create an MS SQL Database Connection to Load Actual Costs" 
help topic. 

 Added a note about creating an MS SQL database connection to load 
actuals costs to the following help topic: 

 “Database Table Selection Page of the Integration Wizard Actuals” 

 “File Selection Page of the Integration Wizard Actuals” 

 “Loading Actual Cost Records from a Database Table” 

https://help.deltek.com/Product/Cobra/8.4/GA/Create%20a%20MS%20SQL%20Database%20Connection%20to%20Load%20Actual%20Costs.html
https://help.deltek.com/Product/Cobra/8.4/GA/Database%20Table%20Selection%20Page%20of%20the%20Integration%20Wizard%20Actuals.html
https://help.deltek.com/Product/Cobra/8.4/GA/File%20Selection%20Page%20of%20the%20Integration%20Wizard%20Actuals.html
https://help.deltek.com/Product/Cobra/8.4/GA/Loading%20Actual%20Cost%20Records%20from%20a%20Database%20Table.html
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Cobra 8.4 Cumulative Update 08 
Released: December 20, 2021 

Enhancements 
This section includes enhancements in this release. 

Allow Freezing of Multiple Columns and Rows in a Report Template 
File 
You can now freeze multiple rows and columns in a report template file. When you run the Report Wizard, 
the changes you made to the report template file are applied to the generated report. 

Support for Primavera P6 20.12 
Cobra now supports Primavera® P6 20.12 beginning with version 8.4 Cumulative 08 onwards. 

Match Work Package Forecast Dates with Dates Loaded from a 
Schedule during Integration 
Cobra now allows you to match work package forecast start and finish dates with dates loaded from a 
schedule during integration. In order to support this feature, the Force existing Work Package baseline 
dates to match the schedule option on the Change Control page of the Integration Wizard has been 
changed to Force existing Work Package dates to match the schedule for, with a list of dates 
displayed depending on the dates being loaded from a schedule. 

 

Change Control Page of the Integration Wizard 
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Software Issues Resolved 
This section includes software issues resolved in this release. 

API » Web Services 

Defect 1544675  

Description: When using Costpoint version 8.1 or earlier, the Integration-Actual Costs process with 
control account code assignments did not work. 

Customers Impacted: This defect affects customers integrating with Costpoint. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WebService.Host.exe 

 Cobra.WebService.dll 

File » Integration Cost Data Export 

Defect 1409679  

Description: When you ran the Cost Data Wizard on a master project while in the Master Projects view, 
Cobra encountered an application error. 

Customers Impacted: This defect affects customers who use the Cost Data Wizard. 

Workaround Before Fix: Run the Cost Data Wizard while in the Projects view instead of the Master 
Projects view. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

File » Integration Wizard-Project Data 

Defect 1431445  

Description: When you performed multi-project concurrent integration using the Integration Wizard to 
load status data and selected the Send to process server option on the Save and Load page, Cobra 
encountered errors. 

Customers Impacted: This defect affects customers who run concurrent Cobra processes. 

Workaround Before Fix: None. 

Files Updated: 

Note: For more information, see the “Change Control Page of the Integration Wizard” help topic. 

https://help.deltek.com/Product/Cobra/8.4/GA/Change%20Control%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
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 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1531564  

Description: When you ran the Integration Wizard to load resource assignments, selected the Delete 
items from Cobra that are no longer in the schedule option on the Change Control page, and filtered 
by Control Account on the Filter page, the integration failed with the "TASCHEDULECLASSES is not an 
array" error. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Additional Notes:  

 The integration completes if the Delete items from Cobra that are no longer in the schedule 
option on the Change Control page is cleared. 

 The integration also fails if you filter by Total Project on the Filter page and select the Delete 
items from Cobra that are no longer in the schedule option on the Change Control page. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Defect 1550439  

Description: When you ran the Integration Wizard to import one file with activity and resource 
assignment data, and a result field on the Import File Field Mapper page contained "BE" within the result 
name, the integration failed with the following error: "SQL: Column '<resultname>' is not found." 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: Use two separate files during import (one activity file and one resource 
assignment file). 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Assignment Export or Import 

Defect 186735 

Description: When you ran the Assignment Export Wizard and the resource exported contained special 
characters (&, <,>, ', ", ..., ’), Cobra displayed an unexpected token error message. 

Customers Impacted: This defect affects customers who use the Assignment Export Wizard. 

Workaround Before Fix: Remove the special character in the resource name. 
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Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Security 

Defect 1538091  

Description: When PM Compass called the Cobra API, Cobra did not authenticate the PM Compass 
users not listed as Cobra users in the EPM Security Administrator (EPM SA) tool. 

Customers Impacted: This defect affects customers who use Cobra with PM Compass. 

Workaround Before Fix: Add the PM Compass users as Cobra users to the EPM SA tool. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.WebService.dll 

 Cobra.WebService.Host.exe 

 ConfigManager.dll 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 DataTool.exe 

 DataTool.UI.Base.dll 

 DataSourceMigration.exe 

 DataSourceMigration.UI.Base.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 
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Document Details 

Cobra 8.4 
Installation 
Guide  

 Added Primavera P6 20.12 to the Supported Deployment Technology table. 

Cobra 8.4 
Technical 
Overview and 
System 
Requirements 
Guide 

 Added Primavera P6 20.12 to the Supported Deployment Technology table. 

Cobra 8.4 
Online Help 

 Updated the Cobra Web Service help topics. 

 Added “The encryption type requested is not supported by the KDC” help topic 
to the Troubleshooting section of the Cobra Web Service and Concurrency in 
Cobra nodes. 

 Added a note about the freezing multiple rows and columns in a report 
template file to the “Report Templates “help topic. 

 Added a note about specifying the data source in 
ServiceIdentityData.DataSourceKey property if Cobra is configured under 
Standalone or Server Deployment environment and that it has multiple data 
sources to the following help topics: 

 Connecting to the Cobra Web Service Host 

 Explaining the SampleClientAPI Code  

 

https://help.deltek.com/product/cobra/8.4/ga/Cobra%20Web%20Services.html
https://help.deltek.com/product/cobra/8.4/ga/the%20encryption%20type%20requested%20is%20not%20supported%20by%20the%20kdc_2.html
https://help.deltek.com/Product/Cobra/8.4/GA/Report%20Templates.html
https://help.deltek.com/Product/Cobra/8.4/GA/Connect%20to%20the%20Cobra%20Web%20Service%20Host.html
https://help.deltek.com/Product/Cobra/8.4/GA/Explaining%20the%20SampleClientAPI%20Code.html
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Cobra 8.4 Cumulative Update 07 
Released: November 5, 2021 

Enhancements 
This section includes enhancements in this release. There are no enhancements in this release. 

Software Issues Resolved 
This section includes software issues resolved in this release. 

API » Web Services 

Defect 1535010  

Description: The Cobra Web Service Gateway did not properly manage the connection channels to the 
Cobra Web Service instances. 

 The Gateway did not dispose the connection channel when it encountered a fault. 

 The Gateway created only two concurrent connections to a remote Cobra Web Service instance. 

Customers Impacted: This defect affects customers who run concurrent Cobra processes. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WebService.Gateway.Host.exe 

 Cobra.WebService.Gateway.dll 

 Cobra.WebService.Gateway.Host.exe.config 

File » Change Password 

Defect 1519243  

Description: The EPM Security Administrator (EPM SA) rule for the minimum password length was 
ignored when changing your password through the Change Password dialog box in the Cobra 
application. 

Customers Impacted: This defect affects customers who set a minimum length for a new login password 
in the EPM SA tool and change it through the Cobra application. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 
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Projects » Project View 

Defect 1507512 

Description: Cobra did not allow you to add more than three digits to the integer part of a milestone 
weight on the Milestones/Steps tab of the Project view. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Additional Notes: Cobra allows a nine-digit integer part for a milestone weight in version 8.3. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Project Processes » Calculate Progress 

Defect 1527599  

Description: When you ran the concurrent progress calculations and the apportionment mapping was set 
to a specific work package target, Cobra did not display warnings about the specific work package target 
being invalid in the log. 

Customers Impacted: This defect affects customers who use the Calculate Progress Wizard to run 
concurrent progress calculations. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Project Processes » Reclass 

Defect 1324048 

Description: When you ran the Reclass Wizard, Cobra encountered performance issues (for example, 
the Reclass process did not finish) if: 

 The Criteria field on the Criteria page was set to value other than Total Project. 

 The Source Class page was set to Copy. 

 The Target Class page was set to Replace Existing. 

Customers Impacted: This defect affects customers who use the Reclass Wizard. 

Workaround Before Fix: Set the Criteria field to Total Project. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 
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 Cobra.Process.dll 

Project Processes » Slip 

Defect 1495826  

Description: When you ran the Slip process, Cobra encountered the "Unknown member OSPREAD" 
error while calculating the forecast values. 

Customers Impacted: This defect affects customers who use the Slip Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. There are no documentation changes in this release. 
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Cobra 8.4 Cumulative Update 06 
Released: September 30, 2021 

Enhancements 
This section includes enhancements in this release. There are no enhancements in this release. 

Software Issues Resolved 
This section includes software issues resolved in this release. 

API » Web Services 

Defect 1420550  

Description: When you deleted resource assignments using the Cobra Web Service, the logs were 
generated and listed under the Assignment Import/Export process on the Process Logs dialog box. 

Customers Impacted: This defect affects customers who use the Cobra Web Service to delete resource 
assignments. 

Workaround Before Fix: None. 

Additional Notes: Process logs for newly deleted resource assignments using the Cobra Web Service 
will be listed under the Resource Assignment Operations process on the Process Logs dialog box. 
Process logs for previously deleted resource assignments using the Cobra Web Service will still be listed 
under the Assignment Import/Export process. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.WebService.dll 

 Cobra.WebService.Host.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Model.WebService.dll 

File » Integration Wizard-Project Data 

Defect 1455829  

Description: When the firewall was set to block port 1433 between the Cobra application and the 
Workstation server on an n-tier deployment and you ran the Integration-MS Project Wizard, the status 
integration of an MS XML file failed. 

Customers Impacted: This defect affects customers who run Cobra on an n-tier deployment. 

Workaround Before Fix: None. 

Files Updated: 
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 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 466863  

Description: When you ran the Integration-MS Project Wizard and selected the Time-phased data is 
expanded in the Microsoft Project database option on the Resource Assignments page, Cobra 
encountered warnings informing you that the start date was later than finish date and no records were 
updated. 

Customers Impacted: This defect affects customers who use the Integration-MS Project Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Defect 1515715  

Description: When you ran the Integration Wizard to load status against a project with the Allow percent 
complete on milestones/steps option on the Project-Preferences tab of the Project Properties dialog 
box cleared, Cobra updated the percent complete values on a milestone. 

Customers Impacted: This defect affects customers who use the Integration Wizard to load status 
against a project with the Allow percent complete on milestones/steps option on the Project-
Preferences tab of the Project Properties dialog box cleared. 

Workaround Before Fix: None. 

Additional Notes: The milestone percent complete values are not displayed in the Cobra UI but included 
in progress calculations. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Assignment Export or Import 

Defect 1160660 

Description: When you ran the Assignment Import Wizard against a resource whose work package start 
and/or finish dates were outside the control account dates, Cobra did not update the control account 
dates to span the new work package dates. 

Customers Impacted: This defect affects customers who use the Assignment Import Wizard. 

Workaround Before Fix: None. 

Files Updated: 
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 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Project Processes » Calculate Forecast 

Defect 1506277  

Description: When you ran the Calculate Forecast Wizard with a forecast class that used the Coded 
Ranges forecast method, and one of the Coded Ranges was mapped to a Retain EAC forecast method, 
the EAC was not retained correctly during forecast calculation. 

Customers Impacted: This defect affects customers who use the Calculate Forecast Wizard against a 
forecast class that uses the Coded Ranges forecast method. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Project Processes » Replan 

Defect 1506983  

Description: When you ran the Replan Wizard, Cobra created a duplicate of the control account and 
work package entries if: 

 The actual costs set to be captured at the control account level or both control and work package 
level. 

 The Create a new Work Package for the replanned Budget/Earned/Actuals option on the 
Options page was selected. 

 The Budget = Earned = Actuals option on the Method page was selected. 

Customers Impacted: This defect affects customers who use the Replan Wizard. 

Workaround Before Fix:  None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Projects » Project View 

Defect 1160697  

Description: When expanding work package-level start or finish dates (Forecast, Early, or Late) beyond 
the account-level start or finish dates (Forecast, Early, or Late), Cobra did not prompt you to extend the 
control account-level dates to span the updated work package-level dates. 
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Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Reports » Reports 

Defect 1516829  

Description: When you ran multiple reports or Cost Data Export processes concurrently on an n-tier 
server or a Cobra Web Service server, Cobra might infrequently encounter the "Subquery not found" 
error. 

Customers Impacted: This defect affects customers who run reports or Cost Data Export processes on 
an n-tier server or a Cobra Web Service server. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1300517 

Description: When you ran a batch report, Cobra encountered the error "The report <report name> 
owned by <previous owner> does not exist." if the report owner in the Included Reports-Batch Reports 
pane was different from the All Reports pane. 

Customers Impacted: This defect affects customers who run a batch report. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Resources.dll 

Resources » Resource View 

Defect 184838  

Description: When you renamed a resource, the parent field on the child resources was not updated to 
match the new parent resource. 

Customers Impacted: This defect affects customers who access a resource file. 
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Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 Help   Updated the description for MethodId in the Calculate Progress Process help 
topic. 

Cobra 8.4 
Cumulative 
Update 05 
Release Notes 

 Updated the description of Cobra 8.4 CU05 Defect 1493227. 

 

https://help.deltek.com/Product/Cobra/8.4/GA/Calculate%20Progress%20Process.html
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Cobra 8.4 Cumulative Update 05 
Released: August 13, 2021 

Enhancements 
This section includes enhancements in this release. 

Support for Concurrent Progress Calculations 
Cobra now supports concurrency in running progress calculations on batches of control accounts. For 
example, a project can be split into multiple jobs, with each job processing a different batch of control 
accounts concurrently. 

To use this feature, you must understand the following information and requirements: 

 You must know the requirements and steps to set up your environment to run a concurrent 
process. 

 You are running the progress calculations against a single project. 

 The apportionment mapping target is set to <Same as Source> or <Same as Source> \ WP for 
all control accounts in the apportionment mapping definition. 

 You have specified the number of control accounts to process per batch in the Control Accounts 
per queue field on the Data Access tab of the Application Preferences dialog box. 

After you set up your environment for the concurrent progress calculations and you run the Calculate 
Progress Wizard, the Run page displays after the Options page. 

 
Run Page of the Calculate Forecast Wizard  

If you select the Send to process server check box, Cobra groups the control accounts into multiple 
batches (according to the value specified in the Control Accounts per queue field), queues the progress 
calculation job to the Process Server, and displays the Process Complete page immediately. 

 

Attention: For more information, see the “Concurrent Progress Calculations” and “Concurrency in 
Cobra” help topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Concurrency%20Requirements.html
https://help.deltek.com/Product/Cobra/8.4/GA/Implementing%20Concurrency.html
https://help.deltek.com/Product/Cobra/8.4/GA/Data%20Access%20Tab%20of%20the%20Application%20Preferences%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.4/GA/Run%20Page%20of%20the%20Calculate%20Progress%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrent%20Progress%20Calculations.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrency%20in%20Cobra.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrency%20in%20Cobra.html
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Ability to Configure the Batch Limit When Running a Concurrent 
Process Through an Application Setting  
Use the Control Accounts per queue field to specify the number of control accounts to process per 
batch when running a concurrent process. By default, this field is set to 100. Possible values are between 
1 and 999. If the Queue field is cleared, this field becomes disabled but the specified value is retained.  

 
Data Access Tab of the Application Preferences Dialog Box 

In version 8.3, Cobra used CALCAPPORTIONMENTBATCHSIZE defined in the SETTING table to 
determine the number of control accounts to process per batch when running a concurrent process. If it is 
present in the database, Cobra now ignores CALCAPPORTIONMENTBATCHSIZE and uses the value 
specified in the Control Accounts per queue field on the Data Access tab of the Application Preferences 
dialog box.  

 

 

Software Issues Resolved 
This section includes software issues resolved in this release. 

Note: For instructions to remove CALCAPPORTIONMENTBATCHSIZE in the database, refer to KB 
Article # 105447 in the Knowledge Center of the Deltek Support Center. 

Attention: See the "Data Access Tab of the Application Preferences Dialog Box" and "Concurrent 
Apportionment Calculations" help topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Data%20Access%20Tab%20of%20the%20Application%20Preferences%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrent%20Apportionment%20Calculations.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrent%20Apportionment%20Calculations.html
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API » Web Services 

Defect 1486342 

Description: When you ran the Calculate Progress process through the Cobra Web Service against a 
project with the Use an adjusting entry to remove Progress from deleted budget option selected and 
the Progress by option set to Time, Cobra incorrectly calculated the earned values. 

Customers Impacted: This defect affects customers who use the Calculate Progress process through 
the Cobra Web Service. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Calendars 

Defect 1493227  

Description: When you performed any of the following to a calendar file, the USR_ID and LASTUPDATE 
fields of that calendar file were not updated: 

 Added a new calendar period. 

 Changed the date label of a calendar set. 

 Changed the flag value of a calendar set. 

 Updated the hours value. 

Customers Impacted: This defect affects customers who access a calendar file. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1493229  

Description: When you changed the label dates of a calendar set, the USR_ID and LASTUPDATE fields 
of the affected calendar periods were not updated. 

Customers Impacted: This defect affects customers who access a calendar file. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 
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 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1493235  

Description: When you added a period to a calendar file, the USR_ID and LASTUPDATE fields of that 
calendar period were not updated. 

Customers Impacted: This defect affects customers who access a calendar file. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1497539  

Description: When you updated the description of a project or an ancillary file (calendar, code, or 
resource) using the Properties dialog box, the USR_ID and LASTUPDATE fields in the WST_DIR table of 
that project or ancillary file were not updated. 

Customers Impacted: This defect affects customers who update the description of a project or an 
ancillary file using the Properties dialog box. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Codes 

Defect 1493230  

Description: When you changed the flags of periods in a calendar set, the USR_ID and LASTUPDATE 
fields of the calendar periods were not updated. 

Customers Impacted: This defect affects customers who access a calendar file. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 
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 Cobra.Model.LoginManager.dll 

Defect 1493224  

Description: When you deleted a code in a code file, the NUMCHILD, USR_ID, and LASTUPDATE fields 
of the parent code in the BDNDETL table were not updated. 

Customers Impacted: This defect affects customers who delete codes in a code file. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

File » Backup 

Defect 1502130 

Description: When you backed up a project, Cobra backed up all of the result columns instead of only 
the result columns of the project. 

Customers Impacted: This defect affects customers who use the Backup function. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

File » Integration Wizard-Ancillary Data 

Defect 1492515  

Description: When you ran the Integration-Ancillary Data Wizard to load a code file, the USR_ID and 
LASTUPDATE fields in the BDNDETL table of the affected codes were not updated. 

Customers Impacted: This defect affects customers who import codes using the Integration-Ancillary 
Data Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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Defect 1492516  

Description: When you ran the Integration-Ancillary Data Wizard to load a resource file, the USR_ID and 
LASTUPDATE fields in the CALCDESC table of the affected resources were not updated. 

Customers Impacted: This defect affects customers who import resources using the Integration - 
Ancillary Data Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1492517  

Description: When you ran the Integration-Ancillary Data Wizard to load a calendar file, the USR_ID and 
LASTUPDATE fields of the affected calendar periods were not updated. 

Customers Impacted: This defect affects customers who import calendars using the Integration-Ancillary 
Data Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

File » Integration Wizard-Project Data 

Defect 1503360  

Description: When you ran the Integration Wizard to load control accounts and work packages only 
without resource assignments, and a new work package was being loaded with dates outside of the 
control accounts, the control account dates were not updated. 

Customers Impacted: This defect affects customers who use the Integration Wizard to load control 
accounts and work packages only without resource assignments. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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Project Processes » Calculate Progress 

Defect 1498464 

Description: When you ran the Calculate Progress Wizard and the apportionment mapping target was 
set to <Same as Source> or <Same as Source> \ WP, Cobra displayed incorrect warning messages 
informing you that no sources were found in the process logs. 

Customers Impacted: This defects affects customers who use the Calculate Progress Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Reports » Reports 

Defect 379024  

Description: When you ran the Time-phased Repeat Sub report and cleared the Show Total check box 
for any of the criteria on the Sub-Totals page of the Report Wizard, the generated report showed zeroes 
on the subtotals. 

Customers Impacted: This defect affects customers who run the Time-phased Repeat Sub report. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.ReportLayoutEngine.dll 

Defect 1496964  

Description: When you ran the Time-phased Repeat Sub report, the rows were not correctly grouped by 
each criteria level. 

Customers Impacted: This defect affects customers who run the Time-phased Repeat Sub report. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.ReportLayoutEngine.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 
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Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 Help   Created/updated the following help topics for the Support for Concurrent 
Progress Calculations feature: 

 Concurrent Progress Calculations 

 Run Concurrent Progress Calculations 

 Run Page of the Calculate Forecast Wizard  

 Data Access Tab of the Application Preferences Dialog Box 

 Calculate Progress using the Calculated Apportionment Progress 
Technique 

 Added the following note to the Class and Results Page of the Integration 
Wizard and Options Page of the Integration Wizard help topics: “Make sure 
that the Allow recalculation of completed Control Accounts and Work Packages 
option on the Recalc Preferences dialog box is selected in order for Cobra to 
calculate the results of the completed work packages.” 

 

https://help.deltek.com/Product/Cobra/8.4/GA/Concurrent%20Progress%20Calculations.html
https://help.deltek.com/Product/Cobra/8.4/GA/Run%20Concurrent%20Progress%20Calculations.html
https://help.deltek.com/Product/Cobra/8.4/GA/Run%20Page%20of%20the%20Calculate%20Progress%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Data%20Access%20Tab%20of%20the%20Application%20Preferences%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.4/GA/Calculate%20Progress%20using%20the%20Calculated%20Apportionment%20Progress%20Technique.html
https://help.deltek.com/Product/Cobra/8.4/GA/Calculate%20Progress%20using%20the%20Calculated%20Apportionment%20Progress%20Technique.html
https://help.deltek.com/Product/Cobra/8.4/GA/Class%20and%20Results%20Page%20of%20the%20Integration%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Class%20and%20Results%20Page%20of%20the%20Integration%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Options%20Page%20of%20the%20Integration%20Wizard.html
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Cobra 8.4 Cumulative Update 04 
Released: July 27, 2021 

Enhancements 
This section includes enhancements in this release. 

Update of the Cobra Web Services DLLs to Support the 64-Bit Web 
Service Client 
The following Cobra Web Service DLLs are updated to support the 64-bit Web Service client: 

 Cobra.Model.WebService.dll 

 Cobra.WebService.ClientAPI.dll 

Software Issues Resolved 
This section includes software issues resolved in this release. 

Codes » Code View 

Defect 487242 

Description: When you renamed a code in a code file, the parent field was not updated on the child 
codes of the renamed code. 

Customers Impacted: This defect affects customers who access a code file. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

File » Integration Wizard-Project Data 

Defect 1424062 

Description: When you ran the Integration Wizard on an n-tier deployment, the temporary files uploaded 
from the client were not deleted from the \Temp folder of the application server. 

Customers Impacted: This defect affects customers who run Cobra on an n-tier deployment. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 
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 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1476938 

Description: When you ran the Integration Wizard against a project with a large COSTELEM table, 
Cobra crashed. 

Customers Impacted: This defect affects all customers. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Calculate Forecast 

Defect 1482037 

Description: When you ran the Calculate Forecast Wizard against a forecast class with PF= User Input 
forecast method, and whose forecast performance factor level was set to Control Account, Cobra did 
not populate the forecast classes with PF= User Input forecast method on the Manual Performance 
Factors page. 

Customers Impacted: This defect affects customers who use the Calculate Forecast Wizard on an 
Oracle database. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Replan 

Defect 945673 

Description: When you ran the Replan Wizard with the Create a new Work Package for the replanned 
Budget/Progress/Actuals option selected on the Options page and actual costs were set to be captured 
at the work package level, Cobra did not update the control account start date to encompass the new 
work package start date. 

Customers Impacted: This defect affects customers who use the Replan Wizard. 

Workaround Before Fix: Run the Validity Check Wizard with the Adjust Control Account dates to 
exactly span Work Package dates option selected on the Business Validations page. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 
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 Cobra.Process.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Installation 
Guide 

 Removed “Microsoft Excel 365 (ProPlus)” from the Supported Deployment 
Technology table. 

Cobra 8.4 
Technical 
Overview and 
System 
Requirements 
Guide 

 Removed “Microsoft Excel 365 (ProPlus)” from the Supported Deployment 
Technology table. 

Cobra 8.4 Help   Updated the Cobra Button node to align the help topics with the user interface. 

Cobra 8.4 
Cumulative 
Update 03 

 Removed Defect 945673. 

 

https://help.deltek.com/Product/Cobra/8.4/GA/Cobra%20Button.html
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Cobra 8.4 Cumulative Update 03 
Released: May 28, 2021 

Enhancements 
This section includes enhancements in this release. There are no enhancements in this release. 

Software Issues Resolved 
This section includes software issues resolved in this release. 

Help 

Defect 1466116 

Description: The Concurrent Apportionment Calculations help topic incorrectly mentioned that running 
concurrent apportionment calculations will process 100 control accounts per batch instead of 30. 

Customers Impacted: This defect affects customers who access the Cobra Help System. 

Workaround Before Fix: None. 

Files Updated: 

 Concurrent Apportionment Calculations.html 

Defect 1464836 

Description: The File Selection Page of the Integration Wizard Actuals and Field Mapper Page of the 
Integration Wizard help topics contained references to XLS format even if it was not supported. 

Customers Impacted: This defect affects customers who access the Cobra Help System. 

Workaround Before Fix: None. 

Files Updated: 

 Field Mapper Page of the Integration Wizard.html 

 File Selection Page of the Integration Wizard Actuals.html 

Project Processes » Calculate Forecast 

Defect 1467347 

Description: When you ran the Calculate Forecast Wizard, Cobra encountered the "Arithmetic overflow" 
error on a Microsoft SQL Server database or the "Value larger than specified precision" error on an 
Oracle database in the following scenarios: 

 The Calculate Performance factors option on the Forecast Class Selection page was selected. 

 The forecast method of the forecast class was PF=1/CPI. 

 The Progress value to calculate CPI was close to zero (less than 0.005). 

 

Customers Impacted: This defect affects customers who use the Calculate Progress Wizard. 
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Workaround Before Fix: For the total Progress with values between 0.001 and 0.01, manually update 
the total Progress resource assignments to zero. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Replan 

Defect 1457065 

Description: When you ran the Replan Wizard on closed control accounts with actuals but without work 
packages and selected the Budget = Progress = Actuals option on the Method page, Cobra created two 
work packages with the same ID. 

Customers Impacted: This defect affects customers who use the Replan Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Online Help 

 Removed references to XLS format in the File Selection Page of the 
Integration Wizard Actuals and Field Mapper Page of the Integration Wizard 
help topics for Defect 1464836. 

 Updated the number of default control accounts per batch to 30 in the 
Concurrent Apportionment Calculations help topic for Defect 1466116. 

https://help.deltek.com/Product/Cobra/8.4/GA/File%20Selection%20Page%20of%20the%20Integration%20Wizard%20Actuals.html
https://help.deltek.com/Product/Cobra/8.4/GA/File%20Selection%20Page%20of%20the%20Integration%20Wizard%20Actuals.html
https://help.deltek.com/Product/Cobra/8.4/GA/Field%20Mapper%20Page%20of%20the%20Integration%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Concurrent%20Apportionment%20Calculations.html
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Cobra 8.4 Cumulative Update 02 
Released: May 06, 2021 

Enhancements 
This section includes enhancements in this release. There are no enhancements in this release. 

Software Issues Resolved 
This section includes software issues resolved in this release. 

Explorer View 

Defect 1443519  

Description: When you used the Save As function to create a copy of an ancillary file, Cobra 
encountered the "The field 'SEQUENCE' / property 'Sequence' for table WST_DIR does not exist in the 
data dictionary" error. 

Customers Impacted: This defect affects customers who upgraded from Cobra 8.2 or earlier version to 
Cobra 8.4 and who use the Save As function on an ancillary file. 

Workaround Before Fix: Export the ancillary file by running an export report and import it back with a 
new name using the Integration Wizard. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

File » Integration Cost Data Export 

Defect 1450704  

Description: When you ran the Cost Data Export process against a large project, the process completion 
took longer than expected. 

Customers Impacted: This defect affects customers who use the Cost Data Export process. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 PPM.CommonData.dll 
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Defect 1454325  

Description: When you ran the Cost Data Export Wizard to generate the Integrated Program 
Management Data Analysis Report (IPMDAR) file, the ContractStartDate value in the generated file was 
incorrect. 

Customers Impacted: This defect affects customers who use the Cost Data Export process to generate 
the IPMDAR file. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

File » Integration wInsight 

Defect 1455256  

Description: When you ran the wInsight Export process to export a structure to the work package while 
actual costs were set to be captured at the control account level or both the control account and work 
package level and there were actuals in the past, Cobra encountered the "Must specify additional 
parameters. Procedure: addsinglepastperiod" error. 

Customers Impacted: This defect affects customers who use the wInsight Export process. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 794947  

Description: When you ran the wInsight Export process against a master project but the calendar was 
not advanced at the master project level, Cobra displayed the "[Error] SQL Error calculating Baseline 
information" generic error message instead of a more descriptive one. 

Customers Impacted: This defect affects customers who use the wInsight Export process on a master 
project. 

Workaround Before Fix: Advance the calendar at the master project level. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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File » Integration Wizard-Project Data 

Defect 1453098  

Description: When you ran the Integration Wizard to load Open Plan data, Open Plan projects not 
shared with the WORLD or SYSADMIN group were not displayed on the Schedule Project Lookup dialog 
box even though the logged in user belonged to the SYSADMIN group. When you entered the name of 
the project in the Schedule Project field on the Project Selection page and clicked Next, Cobra displayed 
the "Invalid schedule project" error. 

Customers Impacted: This defect affects customers who use the Integration Wizard to integrate with 
Open Plan. 

Workaround Before Fix: Using Open Plan, share the project with the WORLD or SYSADMIN group. 

Files Updated:  

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Defect 1457593 

Description: When you ran the Integration Wizard, Cobra did not load all of the resource assignment 
codes. 

Customers Impacted: This defect affects customers who use the Integration Wizard to load resource 
assignments codes. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1413609  

Description: When you ran the Integration Wizard, Cobra changed the baseline finish date to the first 
day of the status date period if: 

 The Apply historical budget changes as an adjusting entry in the current status period 
option on the Integration Wizard Preferences tab of the Project Properties dialog box was 
selected when loading budget that affected the Budget at Completion (BAC). 

 The baseline finish date was within the status period date range. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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Installation 

Defect 1452828  

Description: When you ran the Cobra Database Upgrade Wizard to upgrade your database from version 
8.3 to 8.4, the InstallShield Wizard displayed the "Setup has detected a problem with the database 
upgrade" message even though the database version on the WST_PRD table was updated to 8.4. 

Customers Impacted: This defect affects customers who use the Cobra Database Upgrade Wizard. 

Workaround Before Fix: Upgrade your database from version 8.3 to 8.4 using the Cobra 8.4 installer. 

Files Updated: 

 DeltekCobra84DatabaseUpgradeWizard.exe 

Defect 1192442  

Description: When you installed Cobra on a MS SQL Server database, Cobra did not automatically run 
the Create or Upgrade scripts if TLS 1.0 was disabled. 

Customers Impacted: This defect affects customers who install Cobra on a Microsoft SQL Server 
database with TLS 1.0 disabled, regardless of the operating system. 

Workaround Before Fix: Do one of the following: 

 Enable TLS 1.0 in the registry. 

 Manually run the Create or Upgrade scripts for a MS SQL Server database. 

Additional Notes: Previously, the InstallShield Wizard displayed the following message if it detected that 
TLS 1.0 was disabled on the machine where you were installing Cobra: 

 

The Cobra installer now automatically executes the appropriate scripts and the following prerequisite 
software when it detects that you are using a MS SQL Server database: 

 Microsoft ODBC Driver 17.3 for Microsoft SQL Server Database  

 Microsoft Command Line Utilities 15 for Microsoft SQL Server Database 

See the Documentation Changes section for additional information. 

Files Updated: 

 DeltekCobra84.exe 
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Projects 

Defect 1453575  

Description: When you deleted or purged a project, related records on the LINK table and custom user 
tables were not deleted. 

Customers Impacted: This affects customers who use the Delete Project and Purge Project functions. 

Workaround Before Fix: Manually delete the orphaned records on the LINK table and custom user 
tables. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Project Processes » Freeze Forecast 

Defect 1455426 

Description: When you ran the Freeze Forecast and filtered by Control Account or Work Package with 
multiple control accounts or work packages selected on the Criteria page, Cobra added the existing 
forecast values to the second control account instead of copying the existing forecast values. 

Customers Impacted: This defect affects customers who use the Freeze Forecast Wizard. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Security 

Defect 1444613  

Description: When you launched EPM Security Administrator to define permissions for a role, the Allow 
loading forecast in the current status period option was not displayed in the Projects » Project 
Properties » Preferences tab » Integration Wizard node. 

Customers Impacted: This defect affects customers who upgrade to Cobra 8.4 GA or Cobra 8.4 CU01 
on a Microsoft SQL Server database and use EPM SA. 

Workaround Before Fix: Run the following script: 

"UPDATE WST_PFG 

 SET PFG_ID = '06.05.10.05.03' 

 WHERE PRD_UID = 600 AND PFG_UID = '60236' 

 AND PFG_ID != '06.05.10.05.03'" 
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Additional Notes: This defect is not encountered when performing a new installation of Cobra 8.4 GA or 
Cobra 8.4 Cumulative Update 01. 

Files Updated: 

 Cobra84_Upgrade_SqlServer.sql 

Tools » Validity Check 

Defect 1459309 

Description: When you ran the Validity Check process, Cobra displayed the following warning message: 
"[Warning] The project log differs from the budget detail. Run Reconcile in Project Audit to align the log 
with the budget detail." If you followed the steps to reconcile the project log using the Project Audit Wizard 
and then ran the Validity Check process again, Cobra displayed the same warning message. 

Customers Impacted: This defect affects customers who run the Validity Check process. 

Workaround Before Fix: None. 

Additional Notes:  

 This issue only occurs if the audit log contains values that differ from the time-phased data by > 
10c when summed over the entire project. 

 This issue does not occur if you select the Round audit log transactions to 6 decimal places 
option on the Other tab of the Application Preferences dialog box. 

 Once this fix is applied, Cobra may display the following different warning message when you run 
the Validity Check process: "[Warning] The project log disagrees with the project header. Open 
Project Audit to align the header values." Follow the steps to open the Project Audit Wizard to 
resolve the warning message. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
When upgrading from Cobra 8.4 GA or Cobra 8.4 Cumulative Update 01 to Cobra 8.4 Cumulative 02, the 
Upgrade Installation Wizard displays the Setup Type page and prompts you to select a database upgrade 
script option.  
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This step is needed to apply the fix for Defect 1444613, which corrects the data on the WST_PFG table. 

 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Installation 
Guide 

 Made the following updates for Defect 1192442. 

 Added the following items to the Supported Deployment Technology » 
Embedded Technologies table: 

 Microsoft ODBC Driver 17.3 for Microsoft SQL Server Database  

 Microsoft Command Line Utilities 15 for Microsoft SQL Server 
Database 

 Removed instances of the following note: 

 

 Added bullets 2 and 3 to the following note: 

Note: This is only a data change and not a database structure change. 
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Document Details 

 

Cobra 8.4 
Technical 
Overview and 
System 
Requirements 
Guide 

 Added the following items to the Supported Deployment Technology » Embedded 
Technologies table for Defect 1192442: 

 Microsoft ODBC Driver 17.3 for Microsoft SQL Server Database  

 Microsoft Command Line Utilities 15 for Microsoft SQL Server Database 
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Cobra 8.4 Cumulative Update 01 
Released: March 26, 2021 

Enhancements 
This section includes enhancements in this release. 

Use a Replanned Class as a Target Class During Reclass Through the 
Cobra Web Service 
When you run the Reclass process through the Cobra Web Service, you can now use a Replanned class 
as a Target class if the Source class is a Budget class (included or not-included). 

 

Software Issues Resolved 
This section includes software issues resolved in this release. 

API » PMC Web Services 

Defect 1325684 

Description: When you ran the Replan Wizard against a project with actual costs at the control account 
level or both the control account and work package level, and selected the Create a new Work Package 
for the replanned Budget/Progress/Actuals and the Allow completed Work Package to be 
replanned options on the Options page and the Budget = Progress = Actuals option on the Method 
page, Cobra created a duplicate work package incorrectly if you entered a work package prefix of an 
existing work package. 

Customers Impacted: This defect affects customers who use the Replan process on projects with 
actuals costs at the control account level or both control account and work package level. 

Workaround Before Fix: None. 

Files Updated:  

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WInUI.*.dll 

API » Web Services 

Defect 1412670  

Description: The Cobra Web Service did not support the Scale Retain EAC value of None and instead 
used Currency as the default value. 

Attention: For more information on the Reclass process through the Cobra Web Service, see the 
Web Service Client API Help. 

http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_WebService_ClientAPI_Application_Files_ReclassServiceArguments.htm
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Customers Impacted. This defect affects customers who run the Calculate Forecast process through the 
Cobra Web Service. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Model.WebService.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

 Cobra.Api.exe 

 Cobra.WebService.Host.exe 

 Cobra.WebService.dll 

 Cobra.WebSerivce.ClientAPI.dll 

Defect 1413792  

Description: When you ran a report that did not support roll up results through the Cobra Web Service, 
you encountered the "The Results criteria must be selected as the last sub-total criteria" error  and the roll 
up results were incorrectly validated if the RollupResults parameter on the Report Definition tab of the 
Report Properties dialog box was set to 1. When you ran a report through the Report Wizard, you also 
encountered the same error if the AllowSelectCriteria parameter was set to 1. 

Customers Impacted. This defect affects customers who generate reports. 

Workaround Before Fix: None. 

Additional Notes: Roll-up results are only supported in CrossTab and Summary report types. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Model.WebService.dll 

 Cobra.WebService.Host.exe 

 Cobra.WebService.dll 

Codes » Code View 

Defect 1437008  

Description: When you deleted a code from the code file and then added a new code, the tag of the last 
code from the code file was duplicated on the newly created code.  

Customers Impacted: This defect affects customers who access a code file. 

Workaround Before Fix: Rebuild the code file hierarchy. 

Additional Notes: This issue is also encountered when accessing a resource file. 

Files Updated: 
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 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

File » Integration Cost Data Export 

Defect 1434970  

Description: When you ran the Cost Data Wizard and selected the Use WBS/OBS combination as 
Control Account option on the Data Options page, the description in the exported cost data file was not 
the WBS/OBS description. 

Customers Impacted: This defect affects customers who use the Cost Data Export process. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 PPM.CommonData.dll 

File » Integration Wizard-Project Data 

Defect 1429047  

Description: When you ran the Integration Wizard to load percent complete values from Open Plan and 
there were many activities in one work package, Cobra loaded the incorrect percent complete values. 

Customers Impacted: This defect affects customers who use the Integration Wizard to load percent 
complete values from Open Plan. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1434811  

Description: When you ran the Integration Wizard to load only budget resources and the project 
contained a forecast class with a prefix of the budget class ID being imported, Cobra did not load the 
resource assignments. 

Customers Impacted: This defect affects customers who load resource assignments using the 
Integration Wizard. 

Workaround Before Fix: None. 
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Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1434917  

Description: When you ran the Integration Wizard, Cobra encountered an error about not having enough 
memory to complete the operation in any of following conditions: 

 The integration was run against a project with a large number of time-phased data. 

 The data loaded was filtered by a specific budget or class. 

 The Delete items from Cobra that are no longer in the schedule option on the Change Control 
page was selected. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1433513 

Description: When you ran the Integration Wizard to load resource assignments, resource assignments 
with similar names did not use the correct rate set. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: Run the Recalc Wizard. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Projects » Project Information 

Defect 394418  

Description: When you copied an earned class, Cobra did not copy the Include in Progress information 
to the target project. 

Customers Impacted: This defect affects customers who copy classes. 

Workaround Before Fix: Manually add the new class to the Progress cost set. 

Additional Notes: This issue is also encountered when copying a forecast class. 

Files Updated: 

 Cobra.WinUI.*.dll 
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 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Projects » Project View 

Defect 1424171  

Description: When you used the Move Work Package function, the control account was successfully 
moved to the selected target project but the time-phased records of the first control account listed in the 
source project got deleted. 

Customers Impacted: This defect affects customers who use the Move Work Package function. 

Workaround Before Fix: Use the Copy To function instead of the Move Work Package function. After the 
copy process completes, manually delete the control account. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Reports » Report Information 

Defect 1434993  

Description: When you selected another user who already owned a report with the same name in the 
Owner field on the Access Control tab of the Report Properties dialog box, Cobra did not allow you to 
save the changes but did not display an error message. 

Customers Impacted: This defect affects customers who use the Report Properties dialog box. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Resources.dll 

Security 

Defect 1432012  

Description: When you edited any details of a project on the Project Properties dialog box, Cobra 
required user access to the calendar used by the project. 

Customers Impacted: This defect affects customers who access the Project Properties dialog box. 

Workaround Before Fix: Provide access to the calendar file used by the project. 

Files Updated:  

 Cobra.WinUI.*.dll 
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 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Resources.dll 

Tools » Validity Check 

Defect 1425308  

Description: When you ran the Validity Check Wizard against a project that contained a control account 
with In progress status but all of the work packages associated with it have Planned or Completed status, 
and selected the Business validations » Adjust Control Account dates to exactly span Work 
Package dates option on the Business Validations page, Cobra crashed with the " Unhandled Exception: 
Nullable object must have a value" error. 

Customers Impacted: This defect affects customers who use the Validity Check Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Cobra 8.4 
Online Help 

 Added a note about using a replanned class as a target class when running 
the Reclass process through the Cobra Web Service in the Target Class Page 
of the Reclass Wizard help topic. 

 

https://help.deltek.com/Product/Cobra/8.4/GA/Target%20Class%20Page%20of%20the%20Reclass%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Target%20Class%20Page%20of%20the%20Reclass%20Wizard.html
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Appendix A: Download and Install the 
Cumulative Update  
You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 
cumulative updates, and sub-releases. You can access DSM through the Deltek Support Center or use 
Deltek Software Manager Lite to download Deltek products. 

Access DSM and Download the Cumulative Update 
Use these instructions to download the cumulative update from DSM. 

To download the cumulative update: 

1. Using your web browser, go to https://dsm.deltek.com.  

2. Enter your Deltek Support Center Username and Password, and click Login. 

3. When the Deltek Support Center page displays, click Product Downloads. 

4. On the Deltek Software Manager screen, click Launch Deltek Software Manager. 

5. Click Run Deltek Software Manager.  

6. Log in using your Deltek Customer Care Connect credentials.  

7. In the Deltek Software Manager dialog box, at the top right, click Settings. 

8. In the Settings dialog box, specify the folder where you want to download the Deltek products, 
and click OK. 

 

9. In the left pane, expand the Deltek product that you want to download, if it is not already 
expanded, and select Cumulative Update. 

10. In the table, select the check box that corresponds to the cumulative update that you want to 
download. 

The right pane displays a message stating that the product has been added to the download 
queue. 

 

11. Click Download at the bottom of the left pane to download the product to the folder that you   
selected. 

Note: When you log on for the first time, DSM asks you to select a default folder where 
Deltek products are to be downloaded. You can change this folder anytime in the Settings 
dialog box. 

Note: To view the items in the download queue, click View Download Queue at the bottom 
of the left pane. 

https://dsm.deltek.com/
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Install the Cumulative Update 
Use the instructions below that apply to the Cobra version you use. 

 

For Cobra 8.x and Higher 
The instructions for installing an update for Cobra 8.x and higher depend on your type of deployment. Use 
the instructions below that apply to your deployment scenario. 

 

If You Use a Deployment Server 
Use these instructions if you are using Cobra on a client/server (deployment server) deployment. 

To install on the server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

 

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish.  

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish.  

7. Launch the Deltek Cobra shortcut on client workstations to initiate the update. 

To install on a client workstation: 

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and 
displays the prompt: Do you want to install the upgrade?  

2. Choose Yes to start the installation or choose No to cancel the installation. When the installation 
is completed, the installation wizard closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have an N-Tier Deployment 
Use these instructions if you are using Cobra on an n-tier deployment. 

Note: You must install the entire update package. If an update addresses more than one defect, you 
cannot fix one defect at a time. 

Note: You must install the entire update package. If an update addresses more than one defect, you 
cannot fix one defect at a time. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 
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To install on the server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

 

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish. 

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Launch the Deltek Cobra shortcut on n-tier client workstations to initiate the update. 

To install on an n-tier client workstation: 

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and 
displays the prompt: Do you want to install the upgrade?  

2. Choose Yes to start the installation or choose No to cancel the installation. If you choose Yes, 
the installation wizard copies the updated DeltekCobraWorkstation.exe file locally and 
automatically begins installing files. When the installation is completed, the installation wizard 
closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have a Terminal Services/Citrix Deployment 
Use these instructions if you are using Cobra on a terminal services/Citrix deployment. 

To install on the deployment server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server. 

 

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish. 

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Log on as a Local Administrator on the Terminal Server/Application Server and install the update. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 
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To install on the Terminal Server/ Application Server (the server on which the Cobra client runs): 

1. Log on to the Terminal Server using an account that has Local Administrator privileges. When the 
setup launches, the installation program installs all necessary files and any registry updates and 
makes these changes available to all users who will subsequently log on to the Terminal Server 
session to run Cobra.  

2. Ensure that no instance of Cobra is running.  

3. Browse to the shared Cobra Workstation folder (usually located on the deployment server, as 
\\{DeploymentServerName}\CobraWorkstation\DeltekCobraWorkstation.exe).  

4. Launch the DeltekCobraWorkstation.exe file to install the update. The Welcome screen displays, 
showing that the update is available.  

5. Click Next to start the installation.  

6. When the installation completes, launch the Deltek Cobra shortcut to log into Cobra and confirm 
that the update is installed, meaning that users can now launch Cobra via Terminal 
Services/Citrix sessions. 

If You Have a Standalone Deployment 
Use these instructions if you are using Cobra on a standalone deployment. 

To install on the workstation: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish.  

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Launch the Deltek Cobra shortcut to log into Cobra. 

Confirm that the Cumulative Update is Installed 
Use these instructions to check that the version number reflects the installed cumulative update. 

To confirm that the cumulative update is installed: 

1. Click  » Help » About Deltek Cobra. 

2. Check that the version number reflects the installation of the update. 
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Appendix B: For Additional Information 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 
online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/


 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 

 

http://www.deltek.com/
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